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Troubleshooting 2: Solutions to Common 
Problems

This guide provides troubleshooting strategies for GroupWise® problems that 
can occur with GroupWise clients, GroupWise agents, message delivery, and 
NetWare Administrator. 

! �General Troubleshooting Strategies� on page 9

! �Strategies for Agent Problems� on page 17

! �Strategies for Message Delivery Problems� on page 37

! �Strategies for Administration Problems� on page 65

! �Strategies for Client Problems� on page 79
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I General Troubleshooting Strategies

This part of Troubleshooting 2: Solutions to Common Problems helps you 
resolve GroupWise® problems that are not related to specific error messages 
or components of your system. It can also help with problems that have not 
been resolved by more specific troubleshooting strategies.

! �General GroupWise Troubleshooting Strategies� on page 11

! �General Server/Network Troubleshooting Strategies� on page 15
General Troubleshooting Strategies 9
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General GroupWise Troubleshooting Strategies

If these troubleshooting strategies do not solve the problem, see Novell® 
Support ConnectionTM Worldwide Sites (http://www.support.novell.com/
misc/worldwide.htm).

! �Checking GroupWise Agent Log Files� on page 11

! �Assigning a GroupWise Administrator� on page 12

! �Checking IP Addresses and Port Numbers for TCP/IP Links� on page 12

! �Checking Network Access for Mapped/UNC Links� on page 12

! �Recovering and Rebuilding Domain and Post Office Databases� on page 
13

! �Analyzing and Fixing User and Message Databases� on page 13

! �Verifying GroupWise System Information� on page 13

! �Understanding Message Flow� on page 14

Checking GroupWise Agent Log Files

Problem: You are experiencing message delivery problems.

Action: Use the MTA and POA log files to help you track message delivery problems. 
Set the logging level to Verbose so all processing information is displayed. 
This information can help you determine what the problem is. You should also 
verify the information is being logged to disk. See "Agent Log Files" in 
"Message Flow Monitoring" in the Agent Setup guide.
General GroupWise Troubleshooting Strategies 11
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Assigning a GroupWise Administrator

Problem: No one is receiving error messages generated by the MTA and the POA.

Action: Make sure each domain has an administrator who receives error messages 
generated by the agents. See "Error Notification for the Administrator" in 
"Message Flow Monitoring" in the Agent Setup guide.

Checking IP Addresses and Port Numbers for TCP/IP Links
Problem: Incorrect IP addresses and port numbers can cause problems for the 

GroupWise® client and agents when TCP/IP connections are used. 

Possible Cause: The GroupWise client is set up with the wrong IP address and/or TCP port 
number.

Action: Make sure the GroupWise client is set up with the correct IP address and port 
number for the POA in each user's post office. Or make sure the GroupWise 
name server is running so IP addresses and port numbers can be looked up 
automatically. See the GroupWise Client Setup guide and "Configuring a 
GroupWise Name Server" in "Reconfiguring the POA" in the Agent Setup 
guide.

Possible Cause: The POA is set up with the wrong IP address and/or TCP port number.

Action:  Make sure the POA is set up with the correct IP address and port number. See 
"Using Client/Server Access to the Post Office" in "Reconfiguring the POA" 
in the Agent Setup guide.

Possible Cause:  The MTA is set up with the wrong IP address and/or TCP port number.

Action: Make sure the MTA is set up with the correct IP address and port number. See 
"Using TCP/IP Links between Domains" in "Reconfiguring the MTA" in the 
Agent Setup guide.

Possible Cause: Multiple programs on the same server or workstation are set up with the same 
TCP port number. 

Action: Make sure no duplicate port numbers are in use.

Checking Network Access for Mapped/UNC Links

Problem: Insufficient network rights can cause problems for the GroupWise client and 
agents when direct access to databases and directories is required. The 
following can be signs of insufficient network rights: 

! Access-denied errors 

! Messages are not being delivered 

! One or more users are unable to start GroupWise client 
12 Troubleshooting 2: Solutions to Common Problems
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Action: Check the rights in the post office where the problem is occurring. See 
"GroupWise Agent Rights" and "GroupWise User Rights" in the Security 
guide.

Action: In NetWare® Administrator, you can set the proper user rights for all users in 
a post office or for an individual user. See "Providing Access Rights for Users" 
in "Users" in the Maintenance guide.

Recovering and Rebuilding Domain and Post Office Databases
Problem: Problems with a domain database (WPDOMAIN.DB) or post office database 

(WPHOST.DB) can cause access problems for GroupWise Administrator and 
the GroupWise client, as well as cause message delivery problems. Database 
problems can also cause information in your system to be out of sync (for 
example, a user's information in one post office being different than that user's 
information in another post office). 

Action: See "Maintaining Domain and Post Office Databases" in "Databases" in the 
Maintenance guide. 

Analyzing and Fixing User and Message Databases
Problem: Problems with a user database (USERxxx.DB) or a message database (MSG0-

24.DB) can cause users to lose access to their mailboxes, have incorrectly 
displayed mailbox information, and have message delivery problems. 

Action: See "Maintaining User and Message Databases" in "Databases" and 
"GroupWise Check (GWCheck)" in "Stand-Alone Maintenance Programs" in 
the Maintenance guide.

Verifying GroupWise System Information
Problem: Messages are not being delivered to post offices or domains, or you are 

receiving excessive undeliverable messages. 

Possible Cause: Link configuration problems with your GroupWise system can cause message 
delivery problems. 

Action: Check links between domains. See "Link Configuration" in the Agent Setup 
guide.

Action: Check links to post offices. See "Link Configuration" in the Agent Setup 
guide.

Possible Cause: Incorrect object information can cause message delivery problems.
General GroupWise Troubleshooting Strategies 13
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Action: Check Domain and Post Office object properties. See "Editing Domain 
Properties" in "Domains" and "Editing Post Office Properties" in "Post 
Offices" in the Maintenance guide.

Action: Check agent object properties. See "Configuring the POA in NetWare 
Administrator" in "Preparing Your System for the POA" and "Configuring the 
MTA in NetWare Administrator" in "Preparing Your System for the MTA" in 
the Agent Setup guide.

Possible Cause: Correct information is not being synchronized throughout your GroupWise 
system.

Action: If information is correct in some places but incorrect in others, you can 
synchronize GroupWise information. See "Synchronizing Database 
Information" in "Databases" in the Maintenance guide.

Understanding Message Flow
Problem: You are experiencing message delivery problems. 

Action: Because each component (GroupWise client, MTA and POA) is responsible 
for a specific area of message flow, knowing where the message flow has been 
interrupted can help you discover which component is not functioning 
correctly. See "Message Flow Diagrams" in Troubleshooting 3: Message 
Flow and Directory Structure.
14 Troubleshooting 2: Solutions to Common Problems
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General Server/Network Troubleshooting 
Strategies

If these troubleshooting strategies do not solve the problem, see Novell® 
Support ConnectionTM Worldwide Sites (http://www.support.novell.com/
misc/worldwide.htm).

! �Checking Available System Resources� on page 15

! �Checking Available Disk Space� on page 15

! �Checking File Ownership� on page 16

Checking Available System Resources

Problem: The GroupWise® agents cannot perform well when inadequate system 
resources are available.

Action: Make sure the servers where agents run meet basic system requirements. See 
"POA System Requirements" in "Planning to Install the POA" and "MTA 
System Requirements" in "Planning to Install the MTA" in the Agent Setup 
guide.

Checking Available Disk Space
Problem: When one of the GroupWise programs tries to create or modify a file and there 

is not enough disk space available to complete the task, you will generally get 
a disk full error message. 

Action: Free up space on the disk.
General Server/Network Troubleshooting Strategies 15

Troubleshooting 2: Solutions to Common Problems
104-001298-001
April 10, 2000

Novell Confidential



Manual Rev 99a25 7 March 00
Checking File Ownership

Explanation: The following information applies only if your network operating system is 
Novell® NetWare® and you are using mapped drive connections to post 
offices. 

Problem: NetWare assigns ownership of a file to the creator of the file. Therefore, when 
a GroupWise program (client, agent, or gateway) creates a database file, the 
ownership of that database file is assigned according to the network ID 
currently being used. For example, if Eric is using the GroupWise client 
program and it creates a new message database, Eric is assigned ownership of 
the message database. Problems can arise if a user who owns a database file is 
removed from the network. Problems can also arise if the owner has limited 
available disk space. 

Action: If a database file cannot be accessed, you should check to see who owns the 
database and, if necessary, reassign ownership to a valid network account 
(preferably SUPERVISOR). To look up the locations of databases in domains 
and post offices, see "Editing Domain Properties" in "Domains" and "Editing 
Post Office Properties" in "Post Offices" in the Maintenance guide.

NetWare Note: To check ownership, you can change to the directory and use 
the NDIR command. To reassign ownership, you can use the FILER 
command.
16 Troubleshooting 2: Solutions to Common Problems

Troubleshooting 2: Solutions to Common Problems
104-001298-001
April 10, 2000

Novell Confidential



Manual Rev 99a25 7 March 00
II Strategies for Agent Problems

This part of Troubleshooting 2: Solutions to Common Problems helps you 
resolve problems with individual agents, either the Post Office Agent (POA) 
or the Message Transfer Agent (MTA).

! �Post Office Agent Problems� on page 19

! �Message Transfer Agent Problems� on page 29
Strategies for Agent Problems 17
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Post Office Agent Problems

If these troubleshooting strategies do not solve the problem, see Novell® 
Support ConnectionTM Worldwide Sites (http://www.support.novell.com/
misc/worldwide.htm).

! "Post Office Agent Error Messages" in Troubleshooting 1: Error 
Messages

! �POA Won't Start� on page 20

! �POA Shuts Down Unexpectedly� on page 22

! �POA Statistics Box Shows Requests Pending� on page 23

! �POA Statistics Box Shows Users Timed Out� on page 23

! �POA Statistics Box Shows Undeliverable Users� on page 24

! �POA Statistics Box Shows Problem Messages� on page 24

! �POA Redirection List Shows Failed TCP/IP Connection� on page 24

! �POA Message Transfer Status Box Shows Closed Link� on page 25

! �POA Starts Unwanted TCP/IP Thread� on page 25

! �POA Fails to Deliver Messages� on page 26

! �POA Fails to Respond to MTP Configuration Changes in NetWare 
Administrator� on page 26

! �POA Fails to Respond to Other Configuration Changes in NetWare 
Administrator� on page 27

! �POA Runs Repeated Recoveries on the Same Database� on page 27

! �POA Starts in the Wrong Language� on page 28

! �POA Is Involved with Network Operating System or Hardware 
Problems� on page 28
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POA Won't Start

Problem: The POA does not start. 

Possible Cause: The /home switch is missing.

Action: Make sure the /home startup switch provides the correct path to the post office 
directory where the post office database (WPHOST.DB) resides. This switch 
is required to start the POA and must be provided either in the POA startup 
file or on the command line when you start the POA. See "Starting the POA" 
in the Agent Setup guide.

Possible Cause: The /home switch points to an unavailable location.

Action: Make sure the location specified by the /home startup switch is currently 
available to the POA. If the post office is located on a different server from 
where the POA will run and you are using mapped drive connections, 
preparations for the connection between the POA and the post office are 
required: 

! If you are using the NLMTM POA, you must use the /dn startup switch or 
the /user and /password startup switches to enable the POA to log in to the 
server where the post office is located.

! If you are using the NT POA, you must create the drive mapping to the 
post office before starting the POA.

See "Starting the POA" in the Agent Setup guide.

Possible Cause: The server where the post office resides is down.

Action: Check the status of the server where the post office resides.

Possible Cause: The POA does not have sufficient rights to the post office directory.

Action: Make sure the network rights in the post office are correct. For a list of 
required network rights, see "GroupWise Agent Rights" in the Security guide. 
Start the POA including the /rights switch to determine the specific problem 
the POA is encountering and make corrections as needed.

Possible Cause: The post office database (WPHOST.DB) is damaged.

Action: If the post office database is available to the POA but cannot be read, it may 
be damaged. In NetWare® Administrator, perform maintenance to correct any 
problems with the post office database. See "Maintaining Domain and Post 
Office Databases" in "Databases" in the Maintenance guide.

Possible Cause: The POA server or workstation has inadequate resources.
20 Troubleshooting 2: Solutions to Common Problems
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Action: Make sure the server or workstation where you are trying to run the POA has 
adequate resources to run the POA, especially adequate available memory and 
the current versions of any required network system files. See "POA System 
Requirements" in "Planning to Install the POA" in the Agent Setup guide.

NetWare Note: On NetWare servers, you can use the NetWare Monitor 
NLMTM to check current server resources.

NT Note: On NT workstations, you can use the Performance Monitor in NT 
Administrator Tools.

Possible Cause: The POA is not installed correctly.

Action: Make sure all files required to run the POA are installed. For a list of agent 
files, see "Agent Installation Directories" in Troubleshooting 3: Message 
Flow and Directory Structure.

Possible Cause: A remote document storage area is unavailable.

Action: Make sure the remote server or workstation where the document storage area 
is located is running. Make sure the POA has sufficient rights to log in. Make 
sure the /user and /password or /dn switches have been provided in the POA 
startup file.

Action: As a temporary workaround, you can start the POA with the /noconfig switch, 
so it can start without trying to access the remote document storage area.

Possible Cause: Language files are missing.

Action: If you are using the /language startup switch to run the POA in a particular 
language, the corresponding language files must be installed for the POA to 
run in that language. To determine what language-specific files are required, 
see "Agent Installation Directories" in Troubleshooting 3: Message Flow and 
Directory Structure.

Possible Cause: A POA is already running on the server or workstation.

Action: If you have defined multiple POAs for the same post office in NetWare 
Administrator, the /name switch is required to specify which POA 
configuration to use when you start the POA.

Possible Cause: The POA encounters an error condition.

Action: If you receive an error message when trying to start the POA, look it up in 
"Post Office Agent Error Messages" in Troubleshooting 1: Error Messages.
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POA Shuts Down Unexpectedly

Problem: The POA has been running smoothly, but stops unexpectedly. 

Action: If the POA screen or window is still displayed, exit it. If the normal exit 
procedure does not work, use the system procedure for terminating a program. 

! If you are using the POA on NetWare, use the NetWare UNLOAD 
command. If you have other POAs running on the same server, you 
should exit them before using the UNLOAD command. The UNLOAD 
command unloads all POAs running on the same server and may not 
enable them to terminate gracefully. 

! If you are using the NT POA, close the POA window.

! If you are using the UNIX* POA, close the POA window.

Action: After the POA operation screen is no longer displayed, restart the POA as you 
normally would. See "Starting the POA" in the Agent Setup guide.

Action: If the POA shuts down again, exit it again, reboot the server or workstation, 
then start it again.

Action: Set the POA log level to Verbose for troubleshooting. See "Agent Log Files" 
in "Message Flow Monitoring" in the Agent Setup guide.

Possible Cause: Occasionally, a badly damaged message file can cause the POA to shut down.

Action: Check the contents of the POA input queue in the post office. For the location 
of the POA input queue in the post office, see "Post Office Directory" in 
Troubleshooting 3: Message Flow and Directory Structure. Move the 
message files out of the input queue subdirectories, start the POA, then copy 
the message files back in groups, watching the POA carefully to see if it shuts 
down on a particular message file. If it does, delete the problem message file 
so normal processing can resume.

Action: Rename the post_office\WPCSOUT\OFS directory, then start the POA. This 
creates a new, empty input queue and the POA should run smoothly. Then 
copy the message files from the 0-7 priority subdirectories of 
WPCSOUT\OFS back into the correct priority subdirectory so the POA can 
process them. Copy them in small groups so the damaged message file can be 
identified and removed.

Possible Cause: Occasionally, a damaged database in the post office can cause the POA to shut 
down.

Action: In NetWare Administrator, perform maintenance to correct any problems with 
the databases in the post office. See "Maintaining Domain and Post Office 
22 Troubleshooting 2: Solutions to Common Problems
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Databases" and "Maintaining User and Message Databases" in "Databases" in 
the Maintenance guide.

Possible Cause: Although increasing the number of POA threads from their default settings 
can, in many cases, improve POA performance, creating too many POA 
threads can have undesirable results. 

Action: For guidance is setting an appropriate number of POA threads, see 
"Optimizing the POA" in the Agent Setup guide.

Possible Cause: On a NetWare server, Upgrade Low Priority Threads is set to On.

Action: The POA may run more smoothly if you set Upgrade Low Priority Threads to 
Off. At the server console where the POA is running, type set upgrade 
low priority threads=off.

Possible Cause: Another program on the server or workstation is interfering with the operation 
of the POA.

Action: If the POA continues to be unstable, eliminate other programs running on the 
server or workstation. If the POA is stable when another specific program is 
not running on the same server or workstation with it, a conflict may exist 
between the two programs.

Action: If the POA still continues to be unstable, collect data about what specific 
activities are going on in the post office when problems occur, then see Novell 
Support Connection Worldwide Sites (http://www.support.novell.com/misc/
worldwide.htm).

POA Statistics Box Shows Requests Pending
Problem: GroupWise® client users are using TCP/IP links to the post office. In the POA 

operation screen, the Statistics box shows a large number of pending client/
server requests.

Action: Increase the number of POA threads so that more users can be serviced by the 
POA. See "Adjusting the Number of POA Threads and Connections for 
Client/Server Processing" in "Optimizing the POA" in the Agent Setup guide.

POA Statistics Box Shows Users Timed Out

Problem: GroupWise client users are using TCP/IP links to the post office. In the POA 
operation screen, the Statistics box shows a large number of users timed out. 

Action: Having users timed out does not indicate a problem with the POA, but rather 
a problem with users. Users who have timed out are users for which the POA 
has closed the connection because the GroupWise client was no longer 
Post Office Agent Problems 23
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communicating. Timed out users may not be exiting GroupWise normally or 
may be having other problems with their workstations. The number of timed-
out users may tend to increase on a daily basis during the hour after users leave 
to go home. This is not a problem.

POA Statistics Box Shows Undeliverable Users
Problem: In the POA operation screen, the Statistics box shows a large number of 

undeliverable users. Undeliverable users can be encountered using either 
mapped drive connections or TCP/IP connections. Undeliverable users are 
counted differently from undeliverable messages. For example, a single 
message could be addressed to 10 users; perhaps 9 users received the message 
successfully but 1 user was undeliverable. 

Possible Cause: If messages cannot be delivered to a particular user, that user may have a 
damaged user database (USERxxx.DB).

Action: In NetWare Administrator, perform maintenance to correct any problems with 
the user database so messages can be delivered. See "Maintaining User and 
Message Databases" in "Databases" in the Maintenance guide.

Action: Check the POA log file for other reasons why messages cannot be delivered 
to specific users. See "Agent Log Files" in "Message Flow Monitoring" in the 
Agent Setup guide.

POA Statistics Box Shows Problem Messages
Problem: In the POA operation screen, the Facility Details box shows problem 

messages have been encountered. 

Action: The problem messages number indicates how many messages could not be 
processed by the POA. For strategies, see �Message Is Dropped in the 
PROBLEM Directory in the Post Office� on page 63.

POA Redirection List Shows Failed TCP/IP Connection
Problem: In the POA screen or window, client/server statistics show a failed TCP/IP 

connection. 

Action: Under Client/Server Statistics, use Show Redirection List to list existing 
POAs and the IP addresses of the computers they are running on.

Action: Under Client/Server Statistics, use Check Redirection List to determine which 
connections are currently valid.
24 Troubleshooting 2: Solutions to Common Problems
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Action: If a connection is listed as failed for a POA, use the PING command to see if 
the server or workstation is alive. If the server or workstation does not respond 
to the PING command, you must resolve the TCP/IP problem before the POA 
can use the link successfully.

Possible Cause: TCP/IP is not functioning correctly on the POA workstation.

Action: If the POA is running on a Windows NT* workstation, make sure TCP/IP is 
correctly installed and set up on the workstation where the POA is running.

Possible Cause: Multiple servers or workstations are trying to use the same IP address.

Action: Check for conflicting IP addresses between those used by POA servers and 
workstation and those used by other servers and workstations. Only one server 
or workstation at a time can use the same IP address.

POA Message Transfer Status Box Shows Closed Link
Problem: The POA is configured to communicate with the MTA by way of TCP/IP. 

However, the link between the POA and the MTA displays as Closed.

Action: Check the last closure reason. This information can help you determine the 
source of the problem. Common last closure reasons include:

GWPOA: Host refused connection
GWPOA: No peer listening for connection (B30A)
GWPOA: Port already in use (B309)
GWPOA: TCP/IP connection failure (8908)
GWPOA: TCP/IP disconnected (890F)
GWPOA: TCP/IP read timeout (8912)

Action: See also �POA Fails to Respond to MTP Configuration Changes in NetWare 
Administrator� on page 26.

POA Starts Unwanted TCP/IP Thread
Problem: Even though you have started the POA using the /notcpip startup switch or 

disabled the Enable TCP/IP option in the POA Agent Settings page in 
NetWare Administrator, the POA still starts a TCP/IP thread. 

Explanation: When you select Client/Server Only or Client/Server and Direct as the access 
mode for a post office and use the /notcpip switch when starting a POA, that 
POA does not accept incoming client/server connections from GroupWise 
clients. However, it still starts a single TCP/IP handler thread if TCP/IP is 
configured on the server. The purpose of this TCP/IP thread is to notify any 
GroupWise clients connecting to another POA in the post office via TCP/IP 
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they should reread the database because a new message has been delivered by 
a POA that is not using TCP/IP.

Action: To totally disable TCP/IP processing in a post office, set the access mode for 
the post office to Direct Only and start all POAs servicing that post office with 
the /notcpip switch, or deselect Enable TCP/IP in the Agent Settings page in 
NetWare Administrator. 

POA Fails to Deliver Messages
Problem: The POA is running but no messages are being delivered.

Possible Cause: The post office is closed.

Action: From the MTA operation screen, check the status of the post office. See 
"Displaying MTA Configuration Information" in "Monitoring the MTA" in 
the Agent Setup guide. If the post office is closed, messages are not arriving in 
the post office. Correct the problem with the MTA. See �MTA Status Box 
Shows a Closed Facility� on page 33.

Possible Cause: Message file processing has been turned off.

Action: Make sure that message file processing for the POA has not been turned off 
using the /nomf, /nomfhigh, or /nomflow switches.

POA Fails to Respond to MTP Configuration Changes in NetWare Administrator
Problem: You change a POA link configuration or network address setting in NetWare 

Administrator, but the POA does not respond to the change. For example, you 
change from a mapped or UNC link to a TCP/IP link between the POA and 
the MTA, or you move the POA to a different server or workstation and 
change its IP address. If the configuration change does not replicate 
successfully to the post office database, the MTA link to the post office 
becomes closed.

Action: If you do not want to stop and restart the POA to open a closed post office link, 
change the configuration information back to what it was before you tried to 
change it. The MTA should then be able to open the post office link again. 
Once communication between the POA and MTA is re-established, make the 
configuration changes again. Wait for the configuration changes to be 
replicated to the post office database (WPHOST.DB), then start the POA in its 
new location.

Action: Stop the POA, then start the POA using the /mtpinipaddr and /mtpinport 
switches to specify the new IP address and port the POA should use for 
Message Transfer Protocol (MTP) communication with the MTA. Once the 
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link is established and all administrative messages have been processed, you 
do not need to use these startup switches again.

Action: Stop the POA. Rebuild the post office database (WPHOST.DB) to replicate 
the configuration changes. See "Rebuilding Domain or Post Office Databases" 
in "Databases" in the Maintenance guide.

POA Fails to Respond to Other Configuration Changes in NetWare Administrator
Problem: You change a POA configuration setting in NetWare Administrator, but the 

POA does not respond to the change. For example, you change from direct 
access to client/server mode, or you want to turn off error mail to the 
administrator.

Action: Synchronize the post office database (WPHOST.DB) with the domain 
database (WPDOMAIN.DB). See "Synchronizing Database Information" in 
"Databases in the Maintenance guide.

Action: Stop the POA. Rebuild the post office database (WPHOST.DB) to replicate 
the configuration changes. See "Rebuilding Domain or Post Office Databases" 
in "Databases" in the Maintenance guide.

POA Runs Repeated Recoveries on the Same Database
Problem: The POA continually attempts to recover a particular database but never 

succeeds.

Action: The recovery operation the POA can perform while the database is in use by 
client users is not as powerful as a rebuild operation. Rebuild the problem 
database. See "Maintaining Domain and Post Office Databases" and 
"Maintaining User and Message Databases" in "Databases" in the 
Maintenance guide.

Action: The rebuild operation performed in NetWare Administrator may not be as 
current as the rebuild operation available in the GWCheck utility. See 
"GroupWise Check (GWCheck)" in "Stand-Alone Maintenance Programs" in 
the Maintenance guide.

Action: If the problem is occurring with a user database and it cannot be rebuilt, re-
create the user database. See "Re-creating a User Database" in "Databases" in 
the Maintenance guide.
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POA Starts in the Wrong Language

Problem: You have installed the POA in more than one language and it is starting in a 
different language than you want.

Action: Start the POA using the /language switch to specify the language.

POA Is Involved with Network Operating System or Hardware Problems
Problem: The POA is interacting with the network operating system or hardware in an 

undesirable way.

Possible Cause: If you just updated the NLMTM POA software, you may not have unloaded the 
agent engine (GWENN2.NLM), resulting in a series of "Loader cannot find 
public symbol: symbol" errors on the server console. 

Action: Unload GWENN2.NLM, then start the NLM POA, so that the newly installed 
agent engine is loaded along with it.

Possible Cause: The POA server is running older software, resulting in TCP_HANDLER 
errors on the server console. 

Action: Make sure you are using the most current TCP/IP stack for NetWare.

Possible Cause: The POA server is overburdened, resulting in SYN attacks.

Action: Make sure overall server utilization is not to high. Increase the POA's TCP/IP 
resources. See "Adjusting the Number of POA Threads and Connections for 
Client/Server Processing" in "Optimizing the POA" in the Agent Setup guide.

Possible Cause: The POA server is overburdened. CPU utilization on the server where the 
NLM POA is running jumps to 100% and the POA seems to be taking all 
available resources. GroupWise and other objects on the server are out of sync 
with other servers.

Action: Run DSREPAIR.

Possible Cause: The POA server contains multiple NICs.

Action: The NLM POA automatically binds to the server's default IP address. It does 
not support multihoming. Therefore, you cannot bind different POAs to 
different NICs in the same server.
28 Troubleshooting 2: Solutions to Common Problems

Troubleshooting 2: Solutions to Common Problems
104-001298-001
April 10, 2000

Novell Confidential



Manual Rev 99a25 7 March 00
Message Transfer Agent Problems

If these troubleshooting strategies do not solve the problem, see Novell® 
Support ConnectionTM Worldwide Sites (http://www.support.novell.com/
misc/worldwide.htm).

! "Message Transfer Agent Error Messages" in Troubleshooting 1: Error 
Messages

! �MTA Won't Start� on page 29

! �MTA Shuts Down Unexpectedly� on page 31

! �MTA Status Box Shows a Closed Facility� on page 33

! �MTA Statistics Box Shows Undeliverable Messages� on page 34

! �MTA Statistics Box Shows Errors� on page 34

! �MTA Configuration Status Isn't Open� on page 35

! �MTA Starts in the Wrong Language� on page 35

! �MTA Is Involved with Network Operating System or Hardware 
Problems� on page 35

MTA Won't Start
Problem: The MTA does not start.

Possible Cause: The /home switch is missing.

Action: Make sure the /home startup switch provides the correct path to the domain 
directory where the domain database (WPDOMAIN.DB) resides. This switch 
is required to start the MTA and must be provided either in the MTA startup 
file or on the command line when you start the MTA. See "Starting the MTA" 
in the Agent Setup guide.
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Possible Cause: The /home switch points to an unavailable location.

Action: Make sure the location specified by the /home startup switch is currently 
available to the MTA. If the domain is located on a different server from where 
the MTA will run and you are using mapped drive connections, preparations 
for the connection between the MTA and the domain are required:

! If you are using the MTA on NetWare®, you must use the /dn startup 
switch or the /user and /password startup switches to enable the MTA to 
log in to the server where the domain is located.

! If you are using the NT MTA, you must create the drive mapping to the 
domain and post offices in the domain before starting the MTA.

Possible Cause: The server where the domain resides is down.

Action: Check the status of the server where the domain resides.

Possible Cause: The /work switch points to an unavailable location. Although not required, the 
/work startup switch is useful to specify a local work directory for the MTA 
when the domain it services is located on a different server. Using the /work 
switch to provide a local work directory on the server or workstation where it 
is installed is highly recommended for MTA performance. If the work switch 
is not used, the work directory is placed in the directory specified by the /home 
switch.

Action: Make sure the location of the work directory is available to the MTA.

Possible Cause: The MTA does not have sufficient rights to the domain directory.

Action: Make sure the network rights in the domain are correct. For a list of required 
network rights, see "GroupWise Agent Rights" in the Security guide. 

Possible Cause: The domain database (WPDOMAIN.DB) is damaged.

Action: If the domain database (WPDOMAIN.DB) is available to the MTA but cannot 
be read, it may be damaged. In NetWare Administrator, perform maintenance 
to correct any problems with the domain database. See "Maintaining Domain 
and Post Office Databases" in "Databases" in the Maintenance guide.

Possible Cause: The MTA server or workstation has inadequate resources.

Action: Make sure the server or workstation where you are trying to run the MTA has 
adequate resources to run the MTA, especially adequate available memory 
and the current versions of any required network system files. See "MTA 
System Requirements" in "Planning to Install the MTA" in the Agent Setup 
guide.

NetWare Note: On NetWare servers, you can use the NetWare Monitor 
30 Troubleshooting 2: Solutions to Common Problems

Troubleshooting 2: Solutions to Common Problems
104-001298-001
April 10, 2000

Novell Confidential



Manual Rev 99a25 7 March 00
NLMTM to check current server resources.

NT Note: On NT workstations, you can use the Performance Monitor in NT 
Administrator Tools.

Possible Cause: The MTA is not installed correctly.

Action: Make sure all files required to run the MTA are installed. For a complete list, 
see "Agent Installation Directories" in Troubleshooting 3: Message Flow and 
Directory Structure.

Possible Cause: Language-specific files are missing.

Action: If you are using the /language startup switch to run the MTA in a particular 
language, the corresponding language files must be installed for the MTA to 
run in that language. To determine what language-specific files are required, 
see "Agent Installation Directories" in Troubleshooting 3: Message Flow and 
Directory Structure.

Possible Cause: The MTA is encountering a problem with one specific aspect of its 
functioning.

Action: MTA startup switches are available to disable specific MTA functions while 
allowing other functions to continue normally. For example, the /noada switch 
disables the MTA admin thread. If a specific MTA function is causing the 
MTA to shut down, you may be able to disable that particular function with a 
startup switch. See "MTA Startup Switches" in the Agent Setup guide.

Possible Cause: The MTA encounters an error condition.

Action: If you receive an error message when trying to start the MTA, look it up in 
"Message Transfer Agent Error Messages" in Troubleshooting 1: Error 
Messages.

MTA Shuts Down Unexpectedly
Problem: The MTA has been running smoothly, but stops unexpectedly. 

Action: If the MTA operation screen is still displayed, exit it. If the normal exit 
procedure does not work, use the system procedure for terminating a program. 

! If you are using the MTA on NetWare, use the NetWare UNLOAD 
command. If you have other MTAs running on the same server, you 
should exit them before using the UNLOAD command. The UNLOAD 
command unloads all MTAs running on the same server and may not 
enable them to terminate gracefully. 

! If you are using the NT MTA, close the MTA window.

! If you are using the UNIX* MTA, close the MTA window.
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Action: After the MTA operation screen is no longer displayed, restart the MTA as 
you normally would. See "Starting the MTA" in the Agent Setup guide.

Action: If the MTA shuts down again, exit it again, reboot the server or workstation, 
then start it again.

Action: Set the MTA log level to Verbose for troubleshooting. See "Agent Log Files" 
in "Message Flow Monitoring" in the Agent Setup guide.

Possible Cause: Occasionally, a badly damaged message file can cause the MTA to shut down.

Action: Check the contents of the MTA input queues in the domain and post offices. 
For the locations of the MTA input queues, see "Message Transfer/Storage 
Directories" in Troubleshooting 3: Message Flow and Directory Structure. 
Move the message files out of the priority subdirectories of each input queue, 
start the MTA, then copy the message files back in groups, watching the MTA 
carefully to see if it shuts down on a particular message file. If it does, delete 
the problem message file so normal processing can resume.

Possible Cause: Occasionally, a damaged domain database (WPDOMAIN.DB) can cause the 
MTA to shut down.

Action: In NetWare Administrator, perform maintenance to correct any problems with 
the domain database. See "Maintaining Domain and Post Office Databases" in 
"Databases" in the Maintenance guide.

Possible Cause: Network connections are unstable.

Action: Make sure the connections between the server or workstation where the MTA 
is running and the servers where the domain database (WPDOMAIN.DB) and 
post office database (WPHOST.DB) are located are stable. Repeatedly losing 
connections to servers can cause damage to databases.

Possible Cause: The MTA is encountering a problem with one specific aspect of its 
functioning.

Action: MTA startup switches are available to disable specific MTA functions while 
allowing other functions to continue normally. For example, the /noada switch 
disables the MTA admin thread. If a specific MTA function is causing the 
MTA to shut down, you may be able to disable that particular function with a 
startup switch. See "MTA Startup Switches" in the Agent Setup guide.

Possible Cause: Another program on the server or workstation is interfering with the operation 
of the MTA.

Action: If the MTA continues to be unstable, eliminate other programs running on the 
server or workstation. If the MTA is stable when another specific program is 
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not running on the same server or workstation with it, a conflict may exist 
between the two programs.

Action: If the MTA still continues to be unstable, collect data about what specific 
activities are going on in the domain when problems occur, then see Novell 
Support Connection Worldwide Sites (http://www.support.novell.com/misc/
worldwide.htm).

MTA Status Box Shows a Closed Facility
Problem: In the MTA operation screen, the Status box shows a closed facility. 

Action: Check for details about why the facility is closed. See "Displaying MTA 
Configuration Information" in "Monitoring the MTA" in the Agent Setup 
guide.

Action: Check the configuration status for the closed facility. See �MTA 
Configuration Status Isn't Open� on page 35.

Action: Check the last closure reason. This information can help you determine the 
source of the problem. Common last closure reasons include:

GWMTA: Access denied
GWMTA: Cannot attach to server or volume
GWMTA: Cannot create/read/write files/directories
GWMTA: Cannot move files
GWMTA: Insufficient disk space
GWMTA: Insufficient memory
GWMTA: Insufficient system resources
GWMTA: Link or transport down
GWMTA: No path configured
GWMTA: Undefined link

See "Message Transfer Agent Error Messages" in Troubleshooting 1: Error 
Messages.

Action: In facility details, check the directory paths for mapped and UNC connections 
or the IP addresses and port numbers for TCP/IP links. Make sure the correct 
locations are displayed. Make sure the locations exist, and verify the database 
(WPDOMAIN.DB for a domain or WPHOST.DB for a post office) is there in 
the specified location. Do not use NDS® paths.

Action: If it is a new facility that has never been open, verify the links between 
domains and post offices. See "Link Configuration" in the Agent Setup guide. 
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Make sure mapped and UNC path specifications are in the correct format. Do 
not use NDS full context paths.

Possible Cause: A domain or post office has been moved incorrectly.

Action: When you move a domain or post office to a new location or change its link 
type, you must make various configuration changes in NetWare 
Administrator. If the domain or post office becomes closed as a result, the 
reconfiguration changes may not have replicated down to the agent in the 
reconfigured facility before other changes prevented the replication from 
happening at all. Rebuild the facility database (WPDOMAIN.DB or 
WPHOST.DB). See "Maintaining Domain and Post Office Databases" in 
"Databases" in the Maintenance guide. This will ensure the reconfiguration 
changes are replicated to the facility. Then restart the agent for the facility.

Possible Cause: The MTA server or workstation has insufficient memory.

Action: Make sure the server or workstation where the MTA is running has adequate 
memory. If the MTA starts running out of memory, it starts shutting down 
connections. See "MTA System Requirements" in "Planning to Install the 
MTA" in the Agent Setup guide.

MTA Statistics Box Shows Undeliverable Messages
Problem: In the MTA operation screen, the Statistics box displays a large number of 

undeliverable messages. 

Action: The number of undeliverable messages indicates how many messages could 
not be routed by the MTA. For strategies, see �Message Has Undeliverable 
Status� on page 59. 

MTA Statistics Box Shows Errors
Problem: In the MTA operation screen, the Statistics box shows a large number of 

message errors have occurred. 

Action: The number of message errors indicates how many messages could not be 
processed by the MTA. For strategies, see �Message Is Dropped in the 
PROBLEM Directory� on page 63. 
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MTA Configuration Status Isn't Open
Problem: In the MTA operation screen, the Configuration Status box displays the 

connection status as something other than Open. 

Action: If the configuration status is Closed, the MTA cannot access the database in 
the domain or post office. Make sure the server where the closed facility is 
located is not down. Make sure the MTA can access the server. 

NetWare Note: If you are using the MTA on Novell NetWare, verify the 
settings of the /dn  or /user and /password startup switches for the server where 
the closed facility is located.

NT Note: If you are using the NT MTA, verify the UNC path or drive mapping 
to the closed facility.

Action: If the connection status is Suspended, resume the MTA. See "Suspending/
Resuming a Facility" in "Monitoring the MTA" in the Agent Setup guide.

Action: If the connection status is Open Pending, post offices in the domain are in the 
process of opening and the MTA is clearing its holding queues. Once this is 
accomplished, the MTA begins processing current messages and the status 
will change to Open. No action is necessary.

MTA Starts in the Wrong Language
Problem: You have installed the MTA in more than one language and it is starting in a 

different language than you want.

Action: Start the MTA using the /language switch to specify the language.

MTA Is Involved with Network Operating System or Hardware Problems
Problem: The MTA is interacting with the network operating system or hardware in an 

undesirable way.

Possible Cause: If you just updated the MTA software, you may not have unloaded the agent 
engine (GWENN2.NLM), resulting in a series of "Loader cannot find public 
symbol: symbol" errors on the server console. 

Action: Unload GWENN2.NLM, then start the MTA, so that the newly installed agent 
engine is loaded along with it.

Possible Cause: The MTA server is running older software, resulting in TCP_HANDLER 
errors on the server console. 

Action: Make sure you are using the most current TCP/IP stack for NetWare.

Possible Cause: The MTA server is overburdened, resulting in SYN attacks.
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Action: Make sure overall server utilization is not to high. Increase the MTA's 
tolerance for slow connections. See "Adjusting the MTA Wait Intervals for 
Slow TCP/IP Connections" in "Optimizing the MTA" in the Agent Setup 
guide.

Possible Cause: The MTA server contains multiple NICs.

Action: The NLM MTA automatically binds to the server's default IP address. It does 
not support multihoming. Therefore, you cannot bind different MTAs to 
different NICs in the same server.
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III Strategies for Message Delivery 
Problems

This part of Troubleshooting 2: Solutions to Common Problems helps you 
resolve problems with how the agents are interacting to deliver messages 
throughout your GroupWise system.

! �Message Does Not Arrive� on page 39

! �Message Delivery Is Slow� on page 55

! �Message Has Undeliverable Status� on page 59

! �Message Is Dropped in the PROBLEM Directory� on page 63
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Message Does Not Arrive

Select the configuration where message flow has been disrupted:

! �Message Does Not Arrive in the Local Post Office� on page 39

! �Message Does Not Arrive between Post Offices� on page 41

! �Message Does Not Arrive between Domains� on page 46

Message Does Not Arrive in the Local Post Office
Problem: A message from user A is not being delivered to user B in the same post office. 

This scenario would most likely occur when GroupWise® users connect to the 
post office with mapped drive connections. When users connect with TCP/IP 
connections, they would encounter problems when starting the GroupWise 
client rather than when sending a message. With the client/server access mode 
used for TCP/IP connections, the GroupWise client cannot start if it cannot 
communicate with the POA.

Action: Review the stages of message flow within the local post office. See "Message 
Delivery in the Local Post Office" in Troubleshooting 3: Message Flow and 
Directory Structure.

Action: Answer the following question: 

Is the delivery mode in the post office set to Use App Thresholds?

Yes See �Problem with the Post Office Agent� on page 40.

No See �Problem with Network Rights� on page 40.

Don�t Know See �Determining the Delivery Mode in the Post Office� on page 
40.
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Problem with the Post Office Agent

1111 When the delivery mode in the post office is set to Use App Thresholds 
and the threshold is exceeded, the POA must be running for messages to 
be delivered. Make sure the POA has been started in the post office. See 
"Monitoring the POA" in the Agent Setup guide. If the threshold is not 
exceeded, see �Problem with Network Rights� on page 40. 

2222 If the POA is running successfully and messages still do not arrive, see 
�Problem with Databases� on page 40.

Problem with Network Rights

1111 To deliver a message to another user in the same post office using direct 
access mode, the GroupWise client must have sufficient rights to write 
information to the databases in the post office. For required post office 
rights, see "GroupWise User Rights" in the Security guide.

2222 Compare the listed rights with those in the post office directory where 
user messages are not being delivered successfully.

3333 If the network rights are correct and messages still do not arrive, see 
�Problem with Databases� on page 40.

Problem with Databases

If only one user does not receive messages, that user database (USERxxx.DB) 
may be damaged. If a specific group of users do not receive messages, a 
message database (MSG0-24.DB) may be damaged. In NetWare® 
Administrator, perform maintenance on these files to correct any problems 
with the databases. See "Maintaining User and Message Databases" in 
"Databases" and GroupWise Check (GWCheck)" in "Stand-Alone 
Maintenance Programs" in the Maintenance guide. 

Determining the Delivery Mode in the Post Office

If you do not know which delivery mode is in use in the post office, start 
NetWare Administrator > locate the post office in the browse window > right-
click the Post Office object > click Details > check the delivery mode setting. 
Return to �Message Does Not Arrive in the Local Post Office� on page 39.
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Message Does Not Arrive between Post Offices
Problem: A message from a user in Post Office A is not being delivered to a user in Post 

Office B in the same domain. 

Action: Action: Review the stages of message flow between post offices. See 
"Message Delivery to a Different Post Office" in Troubleshooting 3: Message 
Flow and Directory Structure.

Action: Answer the following question:

Problem with an Individual User in Either Post Office

1111 Stop the MTA for the domain.

2222 Have the user in Post Office A send a low priority test message to a 
recipient in Post Office B. (It's a good idea to test message flow using a 
low priority message because the low priority message queue is typically 
empty.)

3333 Check the post_office\WPCSIN\6 directory in the sender's post office.

4444 Stop the POA for Post Office B.

Can other users in Post Office A send messages to other users in Post Office B? 

Yes See �Problem with an Individual User in Either Post Office� on 
page 41.

No See �Problem between Post Offices for Multiple Users� on page 
43.

Don/t Know See �Problem between Post Offices for Multiple Users� on page 
43.

Has a new message file appeared in the post_office\WPCSIN\6 directory?

No The GroupWise client was unable to create the message file. 
The user may not have sufficient rights to the directory, or 
the NetWare® 3.1 bindery could be damaged. Correct the 
problem, then repeat the test.

Yes The sender can successfully send messages. Continue 
below.
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5555 Restart the MTA in the domain. Observe the MTA operation screen for 
any sign of problems.

6666 Check the post_office\WPCSOUT\OFS\6 directory in Post Office B.

7777 Restart the POA for Post Office B. Observe the POA operation screen for 
any sign of problems.

8888 Recheck the post_office\WPCSOUT\OFS\6 directory in Post Office B.

9999 Check the recipient's mailbox. 

10101010 Check the ownership of the recipient's user database (USERxxx.DB).

 Has a new message file appeared in the post_office\WPCSOUT\OFS\6 
directory?

No See �Problem between Post Offices for Multiple Users� on 
page 43.

Yes The message transferred successfully between post offices. 
Continue below.

 Has the message file disappeared from the post_office\WPCSOUT\OFS\6 
directory?

No The POA was unable to pick up the message. Correct the 
problem, then repeat the test.

Yes The POA has successfully picked up the message. Continue 
below.

Does the new message appear in the recipient�s mailbox?

Yes The POA has successfully delivered the message this time. 
Repeat the test with a different user.

No The POA was unable to deliver the message. Continue 
below.
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11111111 Check the ownership of the message database (MSG0-24.DB) in the 
recipient's post office that corresponds to the message database assigned 
to the sender in the sender's post office.

12121212 In NetWare Administrator, perform maintenance to correct any problems 
with the databases. See "Maintaining User and Message Databases" in 
"Databases" and "GroupWise Check (GWCheck)" in "Stand-Alone 
Maintenance Programs" in the Maintenance guide. Then repeat the test. 

13131313 If the message flow problem has not been resolved by following the 
above troubleshooting steps, see Novell Support Connection® Worldwide 
Sites (http://www.support.novell.com/misc/worldwide.htm).

Problem between Post Offices for Multiple Users

1111 Stop the MTA for the domain.

2222 Have the user in Post Office A send a low priority test message. (It's a 
good idea to test message flow using a low priority message because the 
low priority message queue is typically empty.) 

3333 Check the post_office\WPCSIN\6 directory in Post Office A. 

 Does the ownership of the user database match the recipient's network login 
ID?

No Reset the ownership on the USERxxx.DB file, then repeat 
the test.

Yes Continue below.

 Is the ownership of the message database correct?

No Reset the ownership on the MSG0-24.DB, then repeat the 
test.

Yes Continue below.

Has a new message file appeared in the post_office\WPCSIN\6 directory?

No See �Problem with an Individual User in Either Post Office� 
on page 41.
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4444 Stop the POA for Post Office B.

5555 Restart the MTA for the domain. Observe the MTA operation screen for 
any sign of problems.

6666 Check the post_office\WPCSOUT\OFS\6 directory in Post Office B.

7777 Restart the POA for Post Office B. Observe the POA operation screen for 
any sign of problems.

8888 Recheck the post_office\WPCSOUT\OFS\6 directory in Post Office B. 

Problem with Access to Post Office B

1111 Start NetWare Administrator with read/write rights to the post office.

2222 Open the browser window.

Yes The sender can successfully send messages. Continue 
below.

 Has a new message file appeared in the post_office\WPCSOUT\OFS\6 
directory? 

No See �Problem with Access to Post Office B� on page 44.

Yes The MTA has successfully transferred the file to the POA in 
the recipient's post office. Continue below.

Has the message file disappeared from the post_office\WPCSOUT\OFS\6 
directory? 

No The message transferred successfully between post offices, 
but the POA in Post Office B is unable to pick up the file. See 
Step 8 in �Problem with an Individual User in Either Post 
Office� on page 41.

Yes The message transferred successfully between post offices, 
and the POA in Post Office B has picked up the file. If the 
message still does not arrive in the recipient's mailbox, see 
Step 9 through Step 13 in �Problem with an Individual User 
in Either Post Office� on page 41.

Has a new message file appeared in the post_office\WPCSIN\6 directory?
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3333 Double-click the NDS® container where the domain is located > select 
the Domain object. 

4444 Click Tools > GroupWise Utilities > Link Configuration.

5555 Check the link from the domain to Post Office B. 

6666 If you are using client/server access to Post Office B, check the IP address 
and port displayed on the Network Address page of the POA properties.

7777 Check rights for the MTA to write files into the 
post_office\WPCSOUT\OFS\6 directory in Post Office B. See 
"GroupWise Agent Rights" in the Security guide.

8888 Check for available disk space in the post_office\WPCSOUT\OFS\6 
directory in Post Office B.

Does the link from the domain to the post office specify the correct IP address, 
UNC path, or mapped path to the post office directory for the recipient's post 
office?

No Correct the information. Restart the MTA. Observe the MTA 
operation screen for any sign of problems. Repeat the test.

Yes The link to recipient's post office is correct. Continue below.

Are the IP address and TCP port number for the POA correct?

No Correct the information. Restart the POA in Post Office B. 
Observe the POA operation screen for any sign of problems. 
Repeat the test.

Yes The IP address and port for the POA are correct. Continue 
below.

Are the network rights in the post office correct?

No Reset the rights in the post office, and repeat the test.

Yes Continue below.
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9999 If these troubleshooting steps have not enabled the MTA to write the file 
into the post_office\WPCSOUT\OFS\6 directory in the recipient's post 
office, see Novell Support Connection Worldwide Sites (http://
www.support.novell.com/misc/worldwide.htm).

Message Does Not Arrive between Domains
Problem: A message from a user in Domain A is not being delivered to a user in Domain 

B. 

Action: Review the stages of message flow between domains. See "Message Delivery 
to a Different Domain" in Troubleshooting 3: Message Flow and Directory 
Structure.

Action: Answer the question below:

Problem with an Individual User in Either Domain

1111 Stop the MTA for Domain A.

2222 Have the user in Domain A send a low priority test message to a recipient 
in Domain B. (It's a good idea to test message flow using a low priority 
message because the low priority message queue is typically empty.) 

3333 Check the post_office\WPCSIN\6 directory in the sender's post office. 

 Is there adequate disk space available in the post office?

No Remove unnecessary files from the server to free up disk 
space, then repeat the test. 

Yes Continue below.

Can other users in Domain A send messages to other users in Domain B?

Yes See �Problem with an Individual User in Either Domain� on page 
46.

No See �Problem between Domains for Multiple Users� on page 49

Don�t Know See �Problem between Domains for Multiple Users� on page 49
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4444 Stop the POA for the recipient's post office in Domain B.

5555 Start the MTA for Domain A.Observe the MTA operation screen for any 
sign of problems.

6666 Check the domain\WPCSIN\6 directory in Domain B. 

7777 Restart the POA for the recipient's post office in Domain B. Observe the 
POA operation screen for any sign of problems.

8888 Recheck the post_office\WPCSOUT\OFS\6 directory in the recipient's 
post office in Domain B. 

9999 Check the recipient's mailbox.

Has a new message file appeared in the post_office\WPCSIN\6 directory?

No The GroupWise client was unable to create the message 
files. The user may not have sufficient rights to the directory, 
or the NetWare 3.1 bindery could be damaged. Correct the 
problem, then repeat the test.

Yes The sender can successfully send messages. Continue 
below.

Has a new message file appeared in the domain\WPCSIN\6 directory?

No The message is not transferring between domains. See 
�Problem between Domains for Multiple Users� on page 49.

Yes The message transferred successfully between domains. 
Continue below.

Has the message file disappeared from the post_office\WPCSOUT\OFS\6 
directory?

No The POA was unable to pick up the message. Correct the 
problem, then repeat the test.

Yes The POA has successfully picked up the message. Continue 
below.
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10101010 Check the ownership of the recipient's user database (USERxxx.DB). 

11111111 Check the ownership of the message database (MSG0-24.DB) in the 
recipient's post office that corresponds to the message database assigned 
to the sender in the sender's post office.

12121212 In NetWare Administrator, perform maintenance to correct any problems 
with the databases. See "Maintaining User and Message Databases" in 
"Databases" and "GroupWise Check (GWCheck)" in "Stand-Alone 
Maintenance Programs" in the Maintenance guide. Then repeat the test.

13131313 If the message flow problem has not been resolved by following the 
above troubleshooting steps, see Novell Support Connection Worldwide 
Sites (http://www.support.novell.com/misc/worldwide.htm).

 Does the new message appear in the recipient�s mailbox?

Yes The POA has successfully delivered the message this time. 
Repeat the test with a different user.

No The POA was unable to deliver the message. Continue 
below.

Does the ownership of the user database match the recipient's network login ID?

No Reset the ownership on the user database, then repeat the 
test.

Yes Continue below.

 Is the ownership of the message database correct?

No Reset the ownership on the message database, then repeat 
the test.

Yes Continue below.
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Problem between Domains for Multiple Users

1111 Stop the MTA for Domain A.

2222 Have the user in Domain A send a low priority test message. (It's a good 
idea to test message flow using a low priority message because the low 
priority message queue is typically empty.) 

3333 Check the post_office\WPCSIN\6 directory in the sender's post office. 

4444 Stop the MTA and POA for Domain B.

5555 Restart the MTA for Domain A. Observe the MTA operation screen for 
any sign of problems.

6666 Check the domain\WPCSIN\6 directory in Domain B. 

7777 Restart the MTA for Domain B. Observe the MTA operation screen for 
any sign of problems.

8888 Check the post_office\WPCSOUT\OFS\6 directory in the recipient's post 
office. 

Has a new message file appeared in the post_office\WPCSIN\6 directory?

No See �Problem with an Individual User in Either Domain� on 
page 46.

Yes The sender can successfully send messages. Continue 
below.

Has a new message file appeared in the domain\WPCSIN\6 directory?

No See �Problem with Access to Domain B� on page 50.

Yes The file has successfully transferred to Domain B. Continue 
below. 

Has a new message file appeared in the post_office\WPCSOUT\OFS\6?

No See �Problem with Access to the Post Office in Domain B� on 
page 52.

Yes The MTA has successfully transferred the file to the POA in 
the recipient's post office. Continue below.
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9999 Restart the POA for the recipient's post office in Domain B. Observe the 
POA operation screen for any sign of problems.

10101010 Recheck the post_office\WPCSOUT\OFS\6 directory in the recipient's 
post office.

Problem with Access to Domain B

1111 Start NetWare Administrator with read/write rights to the domain.

2222 Open the browser window.

3333 Double-click the NDS container where Domain A is located > select 
Domain A.

4444 Click Tools > GroupWise Utilities > Link Configuration.

5555 Check the link from Domain A to Domain B. Does it specify the UNC 
path to the domain directory for Domain B?

 Has the message file disappeared from the post_office\WPCSOUT\OFS\6 
directory?

No The message transferred successfully between domains 
and into the recipient's post office, but the POA in the 
recipient's post office is unable to pick up the file. See Step 
8 in �Problem with an Individual User in Either Domain� on 
page 46.

Yes The message transferred successfully between domains 
and into the recipient's post office, and the POA in the 
recipient's post office has picked up the file. If the message 
still does not arrive in the recipient's mailbox, see Step 8 
through Step 13 in �Problem with an Individual User in Either 
Domain� on page 46.

Does the link from Domain A specify the correct IP address, UNC path, or 
mapped path to the domain directory for Domain B?

No Correct the information. Restart the MTA in Domain A. 
Observe the MTA operation screen for any sign of problems. 
Repeat the test.

Yes The link to Domain B is correct. Continue below.
50 Troubleshooting 2: Solutions to Common Problems

Troubleshooting 2: Solutions to Common Problems
104-001298-001
April 10, 2000

Novell Confidential



Manual Rev 99a25 7 March 00
6666 If you are using TCP/IP links between domains, check the IP address and 
port displayed on the Network Address page of the MTA properties. See 
"Using TCP/IP Links between Domains" in "Reconfiguring the MTA" in 
the Agent Setup guide. 

7777 If you are using mapped or UNC links, check rights for the Domain A 
MTA to write files into the domain\WPCSIN\6 directory in Domain B. 

8888 Check for available disk space in the domain\WPCSIN\6 directory in 
Domain B.

9999 If these troubleshooting steps have not enabled the Domain A MTA to 
write the file into the domain\WPCSIN\6 directory in Domain B, see 
Novell Support Connection Worldwide Sites (http://
www.support.novell.com/misc/worldwide.htm).

Are the IP address and TCP port number for the MTA correct?

No Correct the information. Restart the MTA. Observe the MTA 
operation screen for any sign of problems. Repeat the test.

Yes The IP address and port for MTA are correct. Continue 
below.

Are the network rights in the domain correct?

No Reset the rights in Domain B, and repeat the test.

Yes Continue below.

 Is there adequate disk space available in the domain?

No Remove unnecessary files from the server to free up disk 
space, then repeat the test.

Yes Continue below.
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Problem with Access to the Post Office in Domain B

1111 Start NetWare Administrator with read/write rights to the post office.

2222 Open the browser window.

3333 Double-click the NDS container where Domain B is located > select 
Domain B.

4444 Click Tools > GroupWise Utilities > Link Configuration.

5555 Check the link from Domain B to the recipient's post office. 

6666 If you are using a TCP/IP link to the post office, check the IP address 
displayed on the Network Address page of the POA properties.

7777 If you are using a mapped or UNC link to the post office, check rights for 
the Domain B MTA to write files into the post_office\WPCSOUT\OFS\6 
directory in the post office. See "GroupWise Agent Rights" in the 
Security guide. 

Does the link from the domain to the post office specify the correct IP address, 
UNC path, or mapped path to the post office directory for the recipient's post 
office?

No Correct the information. Restart the MTA in Domain B. 
Observe the MTA operation screen for any sign of problems. 
Repeat the test.

Yes The link to recipient's post office is correct. Continue below.

Is the IP address and TCP port number for the POA correct?

No Correct the information. Restart the POA. Observe the POA 
operation screen for any sign of problems. Repeat the test.

Yes The IP address and TCP port number for the POA is correct. 
Continue below.

Are the network rights for the post office correct? 

No Reset the rights in the post office, and repeat the test.

Yes Continue below.
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8888 Check for available disk space in the post_office\WPCSOUT\OFS\6 
directory in the recipient's post office.

9999 If these troubleshooting steps have not enabled the Domain B MTA to 
write the file into the post_office\WPCSOUT\OFS\6 directory in the 
recipient's post office, see Novell Support Connection Worldwide Sites 
(http://www.support.novell.com/misc/worldwide.htm).

 Is there adequate disk space available in the post office? 

No Remove unnecessary files from the server to free up disk 
space, then repeat the test.

Yes Continue below.
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Message Delivery Is Slow

Select the configuration where message flow is slow:

! �Message Delivery Is Slow in the Local Post Office� on page 55

! �Message Delivery Is Slow between Post Offices� on page 56

! �Message Delivery Is Slow between Domains� on page 57

Message Delivery Is Slow in the Local Post Office
Problem: Message delivery between GroupWise® users in the same post office is slower 

than desired.

Action: Review the stages of message flow within the local post office. See "Message 
Delivery in the Local Post Office" in Troubleshooting 3: Message Flow and 
Directory Structure.

Possible Cause: The POA has been installed on a server or workstation with insufficient 
system resources.

Action: Check the utilization and memory on the server or workstation where the POA 
is running to see if other programs are taking more resources than usual. If the 
POA has fewer resources than usual, it can take longer to deliver messages. 
Make sure the server or workstation still meets the system requirements for 
running the POA. See "POA System Requirements" in "Planning to Install the 
POA" in the Agent Setup.

Possible Cause: The POA is not configured optimally.

Action: Go to the server or workstation where the POA is running. Check the POA 
operation screen to see how busy the POA is. If the POA is very busy, it can 
take longer to deliver messages. If the POA needs to handle the current load 
on a permanent basis, see "Optimizing the POA" in Agent Setup.
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Action: TCP/IP links between the GroupWise client and the post office can be faster 
than mapped drive connections. If you are currently using mapped drive 
connections and have TCP/IP available, you could change the configuration 
of the client and POA to use TCP/IP links instead. See "Using Client/Server 
Access to the Post Office" in "Reconfiguring the POA" in the Agent Setup 
guide. 

Message Delivery Is Slow between Post Offices
Problem: Message delivery between GroupWise users in different post offices in the 

same domain is slower than desired. 

Action: Review the stages of message flow between post offices. See "Message 
Delivery to a Different Post Office" in Troubleshooting 3: Message Flow and 
Directory Structure.

Action: If message delivery between users in the same post office is also slower than 
desired, see �Message Delivery Is Slow in the Local Post Office� on page 55. 
Resolve problems in local post offices first before troubleshooting problems 
between post offices.

Possible Cause: The MTA has been installed on a server or workstation with insufficient 
system resources.

Action: Check the utilization and memory on the server or workstation where the 
MTA is running to see if other programs are taking more resources than usual. 
If the MTA has fewer resources than usual, it can take longer to deliver 
messages between post offices. Make sure the server or workstation still meets 
the system requirements for running the MTA. See "MTA System 
Requirements" in "Planning to Install the MTA" in the Agent Setup guide.

Possible Cause: The MTA is not configured optimally.

Action: Go to the server or workstation where the MTA is running. Check the MTA 
operation screen to see how busy the MTA is. If the MTA is very busy, it can 
take longer to deliver messages between post offices. If the MTA needs to 
handle the current load on a permanent basis, see "Optimizing the MTA" in 
the Agent Setup guide.

Possible Cause: The network itself is busy.

Action: Check network traffic between the servers or workstations where the POA and 
MTA are running. Heavy network traffic can slow down the transfer of 
GroupWise messages between post offices.
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Possible Cause: If the MTA has received a large number of administrative messages, user 
messages may be delayed because administrative messages are of higher 
priority.

Action: Check the MTA log file to see what types of messages the MTA is currently 
processing. See "Agent Log Files" in "Message Flow Monitoring" in the 
Agent Setup guide. Once high priority administrative messages are processed, 
user messages will be processed.

Message Delivery Is Slow between Domains
Explanation: Message delivery between GroupWise users in different domains is slower 

than desired. 

Action: Review the stages of message flow between domains. See "Message Delivery 
to a Different Domain" in Troubleshooting 3: Message Flow and Directory 
Structure.

Action: If message delivery between users in the same post office is also slower than 
desired, see �Message Delivery Is Slow in the Local Post Office� on page 55. 
Resolve problems in local post offices first before troubleshooting problems 
between post offices or domains.

Action: If message delivery between users in different post offices in the same domain 
is also slower than desired, see �Message Delivery Is Slow between Post 
Offices� on page 56. Resolve problems between post offices before 
troubleshooting problems between domains.

Possible Cause: The MTA has been installed on a server or workstation with insufficient 
system resources.

Action: Check the utilization and memory on the server or workstation where the 
MTA is running to see if other programs are taking more resources than usual. 
If the MTA has fewer resources than usual, it can take longer to deliver 
messages between domains. Make sure the server or workstation still meets 
the system requirements for running the MTA. See "MTA System 
Requirements" in "Planning to Install the MTA" in the Agent Setup guide.

Possible Cause: The MTA is not configured optimally.

Action: Go to the server or workstation where the MTA is running. Check the MTA 
operation screen to see how busy the MTA is. If the MTA is very busy, it can 
take longer to deliver messages between domains. If the MTA needs to handle 
the current load on a permanent basis, see "Optimizing the MTA" in Agent 
Setup guide.

Possible Cause: The network itself is busy.
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Action: Check network traffic between the servers or workstations where the POA and 
MTA are running. Heavy network traffic can slow down the transfer of 
GroupWise messages between domains. Also check general network 
configuration, looking for slow links, congested hubs, and busy subnets that 
lie along the route GroupWise messages must take between domains.

Possible Cause: Links between domains are not configured optimally.

Action: Check the number of hops the message must travel between domains. You can 
view this information for a message in the mailbox of a user who has problems 
with slow message delivery. If messages are being routed through a large 
number of domains, use the Link Configuration Tool in NetWare 
Administrator to design a more efficient route for messages between domains. 
See "Link Configuration" in the Agent Setup guide.
58 Troubleshooting 2: Solutions to Common Problems

Troubleshooting 2: Solutions to Common Problems
104-001298-001
April 10, 2000

Novell Confidential



Manual Rev 99a25 7 March 00
Message Has Undeliverable Status

Select the configuration where undeliverable messages are occurring:

! �Message Has Undeliverable Status in the Local Post Office� on page 59

! �Message Has Undeliverable Status between Post Offices� on page 60

! �Message Has Undeliverable Status between Domains� on page 60

Message Has Undeliverable Status in the Local Post Office
Problem: A user sends a message to another user in the same post office, and the 

message comes back with a status of Undeliverable. 

Explanation: A status of Undeliverable indicates the user to whom the message is addressed 
does not exist in the post office. 

Possible Cause: The sender manually typed the recipient's address, rather than selecting it in 
the GroupWise Address Book, and typed it incorrectly.

Action: Have the sender select the recipient in the GroupWise Address Book so the 
address is provided automatically, then resend the message.

Possible Cause: If the sender is selecting a group, rather than an individual recipient, from the 
GroupWise Address Book, the group could be out of date if the recipient's user 
ID has changed. 

Action: Re-create the group by selecting each individual user from the Address Book 
to make sure current user IDs are included in the group.

Possible Cause: If the recipient is a brand new user, the sender may have sent the message 
before the recipient was actually created in the post office. 

Action: Verify the existence of the user in the post office before the sender tries to send 
the message again. 

Possible Cause: The recipient's mailbox may be damaged so the message cannot be delivered. 
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Action: In NetWare® Administrator, perform maintenance to correct any problems 
with the recipient's mailbox. See "Maintaining User and Message Databases" 
in "Databases" and "GroupWise Check (GWCheck)" in "Stand-Alone 
Maintenance Programs" in the Maintenance guide.

Message Has Undeliverable Status between Post Offices
Problem: A user sends a message to a recipient in a different post office, and the 

message comes back with a status of Undeliverable.

Explanation: A status of Undeliverable indicates either that the user to whom the message 
is addressed does not exist in the post office, or that the post office does not 
exist in the domain. 

Possible Cause: The sender manually typed the recipient's address, rather than selecting it in 
the GroupWise Address Book, and typed it incorrectly.

Action: Have the sender select the recipient in the GroupWise Address Book so the 
address is provided automatically, then resend the message.

Possible Cause: If the sender is selecting a group, rather than an individual recipient, from the 
GroupWise Address Book, the group could be out of date if the recipient's user 
ID or post office has changed.

Action: Re-create the group by selecting each individual user from the Address Book 
to make sure current user IDs and post offices are included in the group.

Possible Cause: If the recipient is a new user, the sender may have sent the message before the 
recipient was actually created in the post office. 

Action: Verify the existence of the user in the post office before the sender tries to send 
the message again. 

Possible Cause: The recipient's mailbox may be damaged so the message cannot be delivered. 

Action: In NetWare Administrator, perform maintenance to correct any problems with 
the recipient's mailbox. See "Maintaining User and Message Databases" in 
"Databases" and "GroupWise Check (GWCheck)" in "Stand-Alone 
Maintenance Programs" in the Maintenance guide. 

Message Has Undeliverable Status between Domains
Problem: A user sends a message to a recipient in a different domain, and the message 

comes back with a status of Undeliverable. 

Explanation: A status of Undeliverable indicates either the user to whom the message is 
addressed does not exist in the post office, or the post office does not exist in 
the domain, or that the domain does not exist in the GroupWise system. 
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Possible Cause: If the sender is selecting a group, rather than an individual recipient, from the 
GroupWise Address Book, the group could be out of date if the recipient's user 
ID or post office has changed.

Action: Re-create the group by selecting each individual user from the Address Book 
to make sure current user IDs and post offices are included in the group.

Possible Cause: If the recipient is a new user, the sender may have sent the message before the 
recipient was actually created in the post office. 

Action: Verify the existence of the user in the post office before the sender tries to send 
the message again. 

Possible Cause: The recipient's mailbox may be damaged so the message cannot be delivered. 

Action: In NetWare Administrator, perform maintenance to correct any problems with 
the recipient's mailbox. See "Maintaining User and Message Databases" in 
"Databases" and "GroupWise Check (GWCheck)" in "Stand-Alone 
Maintenance Programs" in the Maintenance guide. 

Possible Cause: If the sender is selecting a group, rather than an individual recipient, from the 
GroupWise Address Book, the group could be out of date if the recipient's user 
ID, post office, or domain has changed. 

Action: Re-create the group by selecting each individual user from the Address Book 
to make sure current user IDs, post offices, and domains are included in the 
group.

Possible Cause: The sender is mailing to a user in an external GroupWise system and has an 
incorrect address.

Action: Have the sender verify the address with the recipient, then send the message 
again. 

Possible Cause: If the recipient is a brand new user, the sender may have sent the message 
before the recipient was actually created in the post office. 

Action: Verify the existence of the user in the post office before the sender tries to send 
the message again.

Possible Cause: The recipient's mailbox may be damaged so the message cannot be delivered. 

Action: In NetWare Administrator, perform maintenance to correct any problems with 
the recipient's mailbox. See "Maintaining User and Message Databases" in 
"Databases" and "GroupWise Check (GWCheck)" in "Stand-Alone 
Maintenance Programs" in the Maintenance guide. 

Possible Cause: Links between domains and post offices are not set up correctly.
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Action: Check the link configuration in NetWare Administrator to make sure links 
between domains and post offices are set up correctly. See "Link 
Configuration" in the Agent Setup guide.
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Message Is Dropped in the PROBLEM Directory

Select the location of the PROBLEM directory:

! �Message Is Dropped in the PROBLEM Directory in the Post Office� on 
page 63

! �Message Is Dropped in the PROBLEM Directory in the Domain� on 
page 64

Message Is Dropped in the PROBLEM Directory in the Post Office
Problem: In the Statistics box in an agent operation screen, you notice that some 

problem messages or message errors have been encountered. 

Explanation: Problem messages are message files that cannot be processed by the agents for 
a variety of reasons. Each file has an extension that indicates which agent 
(POA or MTA) placed the file in the post_office\WPCSOUT\PROBLEM 
directory. 

Action: If GroupWise® is currently set up to mail problem messages to the GroupWise 
administrator, check the mailbox of the GroupWise administrator for 
messages with problem message files attached. Follow the instructions in the 
message for handling the problem files.

Action: Sometimes a problem file can be handled successfully if requeued. Place the 
file into the proper priority 0 subdirectory, as indicated by the extension on the 
message file. Placing it in the 0 subdirectory gives it high priority for 
reprocessing. If conditions have changed on the network, the message may be 
able to be processed.

If the message still cannot be processed after being requeued, it has been 
damaged in some way that makes it unreadable. This should happen only very 
rarely.
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Action: If your GroupWise system reports a large number of problem messages, you 
should determine what is causing the damage. See Novell Support 
Connection® Worldwide Sites (http://www.support.novell.com/misc/
worldwide.htm).

Message Is Dropped in the PROBLEM Directory in the Domain
Problem: In the Statistics box in an agent screen or window, you notice that some 

problem messages or message errors have been encountered. 

Explanation: Problem messages are message files that cannot be processed by the agents for 
a variety of reasons. Therefore, they are placed in the 
domain\WPCSOUT\PROBLEM directory.

Action: If GroupWise is currently set up to mail problem messages to the GroupWise 
administrator, check the mailbox of the GroupWise administrator for 
messages with problem message files attached. Follow the instructions in the 
message for handling the problem files.

Possible Cause: Incorrect conversion between GroupWise 5.x and GroupWise 4.1 domains. 

Action: If your GroupWise system includes both versions of GroupWise, make sure 
each domain is configured correctly for its version of GroupWise. 

Possible Cause: Files placed in the PROBLEM directory in the domain have been damaged in 
some way that makes them unreadable.

Action: None. This should happen only very rarely.

Action: If your GroupWise system reports a large number of problem messages, you 
should determine what is causing the damage. See Novell Support Connection 
Worldwide Sites (http://www.support.novell.com/misc/worldwide.htm).
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IV Strategies for Administration 
Problems

This part of Troubleshooting 2: Solutions to Common Problems helps you 
resolve problems running GroupWise® Administrator and problems 
managing GroupWise Document Management Services (DMS).

! �GroupWise Administrator Problems� on page 67

! �Document Management Services Problems� on page 73
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GroupWise Administrator Problems

If these troubleshooting strategies do not solve the problem, see Novell 
Support Connection® Worldwide Sites (http://www.support.novell.com/misc/
worldwide.htm).

! "GroupWise Administrator Error Messages" in Troubleshooting 1: Error 
Messages

! �GroupWise Administrator Can't Access the Domain Database� on page 
68

! �You Aren't Connected to the Right GroupWise Domain� on page 68

! �You Can't Create or Delete GroupWise Objects� on page 68

! �Pending Operations Aren't Completed� on page 69

! �Creation of a Secondary Domain Isn't Completed� on page 69

! �Addressing Rules Aren't Working� on page 69

! �Synchronization Isn't Working� on page 70

! �You Can't Move a User� on page 70

! �You Can't Import Users� on page 71

! �Administrator-Defined Fields Are Missing from the Address Book� on 
page 71

! �GroupWise Administrator Is Missing from NetWare Administrator� on 
page 71

! �NDS Objects Aren't Linking to GroupWise Objects� on page 71

! �Help Doesn't Display in GroupWise Administrator� on page 72

! �You Encounter Gateway Setup Problems� on page 72
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GroupWise Administrator Can't Access the Domain Database

Problem: You run NetWare® Administrator but cannot access the domain where you 
need to make changes.

Possible Cause: You are not connected to the correct domain.

Action: Make sure you are connected to the correct domain. See "System Connection" 
in "GroupWise Maintenance Tools in NetWare Administrator" in the 
Maintenance guide.

Possible Cause: You don�t have sufficient rights.

Action: Make sure you started NetWare Administrator with sufficient rights to modify 
the domain object.

Possible Cause: The domain database (WPDOMAIN.DB) is damaged.

Action: Rebuild the domain database. See "Rebuilding Domain or Post Office 
Databases" in "Databases" in the Maintenance guide.

You Aren't Connected to the Right GroupWise Domain

Problem: You are attempting to modify a GroupWise® object in NetWare Administrator. 
A message informs you that you cannot perform the action because you are 
not connected to the correct GroupWise domain. 

Action: Connect to the correct GroupWise domain. See "System Connection" in 
"GroupWise Maintenance Tools in NetWare Administrator" in the 
Maintenance guide.

You Can't Create or Delete GroupWise Objects
Problem: You are running NetWare Administrator to create or delete a GroupWise 

object. However, you are unable to perform the action. 

Possible Cause: You are not connected to the correct domain.

Action: Make sure you are connected to the correct domain. See "System Connection" 
in "GroupWise Maintenance Tools in NetWare Administrator" in the 
Maintenance guide.

Possible Cause: You do not have sufficient NetWare rights.

Action: Make sure you started NetWare Administrator with sufficient rights to the 
GroupWise object.

Possible Cause: You do not have sufficient directory rights.
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Action: Make sure you have sufficient rights to the directory structure associated with 
the GroupWise domain or post office. See "GroupWise Administrator Rights" 
in the Security guide.

Pending Operations Aren't Completed

Problem: You have performed some actions on GroupWise objects in NetWare 
Administrator. You see them listed in the Pending Operations dialog box, but 
they are not completed. 

Action: Use the Retry option or the Undo option in the Pending Operations dialog box. 
See "Pending Operations" in "GroupWise Maintenance Tools in NetWare 
Administrator" in the Maintenance guide.

Action: Check the MTA log files to see if the administrative message has been 
delivered. See "Agent Log Files" in "Message Flow Monitoring" in the Agent 
Setup guide.

Possible Cause: The MTA is not running.

Action: Make sure that the MTA is running and that no post offices or domains are 
closed. See "Monitoring the MTA" in the Agent Setup guide.

Creation of a Secondary Domain Isn't Completed
Problem: You are creating a secondary domain, but the process is interrupted before 

completion. For example, you click Cancel, or a power failure or hardware 
failure occurs. The result is that the new secondary domain appears in the 
GroupWise view but does not appear in the NDS® tree. 

Action: First, graft the new secondary domain into the NDS tree. See "Graft 
GroupWise Objects" in "GroupWise Maintenance Tools in NetWare 
Administrator" in the Maintenance guide. Next, select the secondary domain 
in the NDS tree, then rebuild it. See "Rebuilding Domain or Post Office 
Databases" in "Databases" in the Maintenance guide.

Addressing Rules Aren't Working
Problem: You created an addressing rule; however, it isn't working for users in the 

GroupWise client. 

Possible Cause: You didn�t enable the addressing rules after creating them.

Action: Addressing rules must be enabled after being created. See "Addressing Rules" 
in "Addressing" in the Maintenance guide.

Possible Cause: The addressing rules haven�t replicated to the user�s post office.
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Action: Rebuild the post office database (WPHOST.DB). See "Rebuilding Domain or 
Post Office Databases" in "Databases" in the Maintenance guide.

Synchronization Isn't Working
Problem: The MTA automatically synchronizes information throughout your 

GroupWise system. However, you notice that some GroupWise information 
is not being synchronized. 

Historical Note: In GroupWise 5.2 and earlier, the ADA performed 
synchronization. This ADA function is now incorporated into the MTA.

Action: Manually synchronize the information in NetWare Administrator. See 
"Synchronizing Database Information" in "Databases" in the Maintenance 
guide.

You Can't Move a User
Problem: You attempt to move a user from one post office to another, but the user does 

not appear in the destination post office. 

Possible Cause: The agents aren�t functioning properly.

Action: Make sure the MTA and POA are configured correctly and are running. See 
"Message Flow Monitoring" in the Agent Setup guide.

Possible Cause: The move hasn�t been completed yet.

Action: If you are moving a user from one domain to another, view the pending 
operations to see if the operation is complete. See "Pending Operations" in 
"GroupWise Maintenance Tools in NetWare Administrator" in the 
Maintenance guide.

Possible Cause: The move failed.

Action: Check the MTA and POA log files to see if the process failed. If so, repeat the 
move. See "Agent Log Files" in "Message Flow Monitoring" in the Agent 
Setup guide.

Possible Cause: There is insufficient disk space in the destination post office.

Action: Verify the post office to which you are moving the user has sufficient free disk 
space.
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You Can't Import Users
Explanation: You are trying to import users into GroupWise, but the operation fails. 

Possible Cause: The user information isn�t formatted correctly.

Action: Make sure the user information is correctly formatted with the proper 
delimiters. The delimiter between fields must be a comma (,). The delimiter 
between records must be a form feed. No other delimiters are recognized. See 
"Import" in "GroupWise Maintenance Tools in NetWare Administrator" in 
the Maintenance guide.

Possible Cause: The user information file is in the wrong format.

Action: Make sure the user information file is in ASCII text format. A file created by 
a word processor, such as WordPerfect*, cannot be used to import users.

Administrator-Defined Fields Are Missing from the Address Book
Problem: You migrated users from GroupWise 4.1 to GroupWise 5.x. User information 

in administrator-defined fields is missing. 

Explanation: GroupWise 5.x user information must also be available as NetWare user 
information. If you created administrator-defined fields in GroupWise 4.1 to 
hold information that cannot be stored as NetWare user information, that 
information is no longer available in GroupWise 5.x. 

GroupWise Administrator Is Missing from NetWare Administrator
Problem: You installed GroupWise Administrator to make it available as part of 

NetWare Administrator. Later, the GroupWise Administrator features no 
longer appear in NetWare Administrator. For example, GroupWise objects 
display as question marks.

Action: Make sure the icon you use to start NetWare Administrator is 
NWADMN32.EXE, not an earlier version, such as NWADMIN.EXE, 
NWADMN95.EXE, or NWADMNNT.EXE.

NDS Objects Aren't Linking to GroupWise Objects
Problem: In NetWare Administrator, NDS objects are not linking successfully to 

GroupWise objects. 

Action: Record the conditions under which you encountered the problem. For 
technical services, see Novell Support Connection Worldwide Sites (http://
www.support.novell.com/misc/worldwide.htm).
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Help Doesn't Display in GroupWise Administrator

Problem: You click Help in NetWare Administrator but the Help file doesn't open. A 
Windows* message advises trying to open the Help file in a different 
directory.

Explanation: Windows Help files are accessed by means of a .GID file with the same name 
as the Help file. For example, the GroupWise Administrator Help file is 
named GWADMIN.HLP and it has a corresponding .GID file named 
GWADMIN.GID, where the location of the Help file is encoded.

Possible Cause: If you run NetWare Administrator from several different workstations, with 
different drive mappings to the server where NetWare Administrator is 
installed, the location of the Help file, as encoded in the GWADMIN.GID file, 
may not be valid for all workstations. 

Action: To avoid this problem, use identical drive mappings for all workstations from 
which you run NetWare Administrator.

You Encounter Gateway Setup Problems
Problem: You don't know how to integrate the gateway you are using in NetWare 

Administrator. 

Action: Each GroupWise 4.1 gateway is independently configured. GroupWise lets 
you configure most of the 4.1 gateways with gateway-specific configuration 
tools (DLL programs) that are integrated in GroupWise Administrator. These 
gateway DLL programs are located in your \PUBLIC\WIN32 and 
\PUBLIC\WIN32\NLS\xx directories. 

If no DLL exists for your gateway, GroupWise Administrator generates a 
"DOS launch" button on the Gateway Specific Setup page. You can click this 
button to launch the gateway setup program (GWSETUP.EXE) that resides in 
the gateway's home directory. This DOS-based program will help you 
configure your gateway's unique settings. For more information about the 
DOS gateway setup program, see "Configuring Gateway-Specific Settings" in 
the printed gateway guide that shipped with the gateway. See also Gateway 
Guides (http://www.novell.com/documentation/lg/gw55/docui/
gateways.html).

IMPORTANT: Before you click the DOS launch button, make sure the system 
connection for GroupWise Administrator points to the domain where the gateway 
is located. If the GroupWise Administrator is connected to another system, a "Host 
record not found" error will display and the gateway setup will terminate. 
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Document Management Services Problems

If these troubleshooting strategies do not solve the problem, see Novell 
Support Connection® Worldwide Sites (http://www.support.novell.com/misc/
worldwide.htm).

! �Documents Are Not Listed in User's Folder� on page 73

! �User Can't Exit GroupWise Because a Document Isn't Closed� on page 
73

! �GroupWise Can't Monitor a Non-Integrated Application� on page 74

! �User Wants to Turn Off Integrations Temporarily� on page 75

! �Administrator Wants to Remove Integrations Permanently� on page 75

! �Administrator Wants to Add a Custom Integration� on page 76

! �Administrator Wants to Distribute Standardized Integrations� on page 
77

Documents Are Not Listed in User's Folder

Problem: A user creates or imports a document in the GroupWise® client. The document 
does not appear in the folder where the user expects to find it. 

Action: On the GroupWise client toolbar, click Show Personal Items. Documents are 
considered personal items and are not listed when personal items are filtered 
out. 

User Can't Exit GroupWise Because a Document Isn't Closed
Problem: A user edits a document in a non-integrated application. The user has exited 

the application. However, when the user tries to exit the GroupWise client, the 
client indicates that a document is still open or has not been returned to the 
GroupWise library. 
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Action: Click Yes in the error dialog box to let GroupWise attempt to return the 
document to the GroupWise library.

Action: Locate the open document and make sure it is closed properly. Look in the 
Work in Progress folder for open documents.

GroupWise Can't Monitor a Non-Integrated Application
Problem: The user edits a document and the GroupWise client indicates the application 

cannot be monitored. Therefore, the user must return the document to the 
GroupWise library manually. 

Explanation: The manner in which the GroupWise client monitors applications can be 
modified using settings in the GWAPPINT.INF file, located in the 
\WINDOWS\SYSTEM directory. This file contains information about 
integrating applications and monitoring non-integrated applications that are 
started from the GroupWise client. 

Possible Cause: Some applications, such as WordPerfect* 7.0 and Lotus* Word Pro 96, are 
integrated through ODMA. Other applications, such as Microsoft* Word 7.0 
and Excel 7.0, are integrated through application macros. If an integrated 
application is not set up correctly, it is handled as a non-integrated application. 

Normally, Setup detects an application is installed and then allows the user to 
choose whether or not to have integrations installed for that application. If the 
application setup didn't run correctly, the GroupWise client may not detect 
that the integration installed. If necessary, integrations can be installed 
manually.

Action: For ODMA applications, the GWAPPINT.INF file needs to contain an 
Integrations=2 entry for the application. In addition, the following DLL 
programs are copied to the \WINDOWS\SYSTEM directory when Setup is 
run: ODMA32.DLL, GWODM132.DLL, and GWODM1xx.DLL. The name 
of the GWODM1xx.DLL depends on which language was selected when 
Setup was run. 

Action: For applications that use an integration macro, the GWAPPINT.INF file needs 
to contains an Integrations=1 entry for the application. There should 
also be an integration macro installed in the application's macro startup 
directory.

Possible Cause: For non-integrated applications, the GroupWise client attempts to monitor 
when an application terminates so open documents can be returned to the 
GroupWise library automatically. If the GroupWise client wasn't able to 
determine the information needed to monitor the application termination, the 
user is instructed to return documents manually. 
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Action: Return documents manually. Save and exit each document. In the GroupWise 
client, right-click each document reference > click Actions > Reset Document 
Status.

Possible Cause: Some applications do not start quickly enough for the GroupWise client to 
detect that they have started.

Action: You can change the amount of time the GroupWise client allows for the 
application to start using the WaitInterval setting. 

Action: If problems persists, you can turn off the message for the application. Use 
ShowMessage=0 in the GWAPPINT.INF file to turn off the message. 

Action: See the GWAPPINT.INF file in the \WINDOWS\SYSTEM directory for 
more information.

User Wants to Turn Off Integrations Temporarily
Problem: The user wants to turn off application integrations so the GroupWise client no 

longer performs document management functions when the application is 
used. However, the user wants to be able to turn integrations back on easily. 

Action: You can turn off integration for all integrated applications. From the Tools 
menu in the GroupWise client, click Options > Documents > deselect Enable 
Integration with Other Applications. This turns off all integrations. You 
cannot turn off integration for an individual application while leaving other 
applications integrated. 

Administrator Wants to Remove Integrations Permanently
Problem: The administrator wants to permanently turn off one or more application 

integrations so the GroupWise client no longer performs document 
management functions. 

Action: Have users rerun GroupWise client Setup and deselect integrated applications 
so they are no longer integrated when the client software is updated. Then the 
macro must be removed from the startup directories for Microsoft Word or 
Excel as described below.

Action: The administrator can edit the GWAPPINT.INF file, located in the 
\WINDOWS\SYSTEM directory, to remove the integration information. 

! Integrations=2: If an application has the setting Integrations=2 for 
an ODMA-compliant application, you can change to 
Integrations=0 for no integration. 
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! Integrations=1:If an application has the setting Integrations=1, 
indicating it is integrated using a startup macro, you must change to 
Integrations=0 for no integration and delete the startup macro. For 
example, to remove integration for Word, you would need to delete the 
GWNORMxx.DOT macro from the Word startup directory. For Excel, 
you would need to delete the GWXL95.XLA macro from the XLSTART 
directory and reset the Excel toolbars.

Administrator Wants to Add a Custom Integration 

Problem: The administrator wants to integrate a new application with the GroupWise 
client. 

Explanation: Integrations are set up using the GWAPPINT.INF file, located in the 
\WINDOWS\SYSTEM directory. This file contains information about 
integrating applications started from the GroupWise client. It can be edited 
using an ASCII or ANSI text editor. 

Action: To integrate a new application, create a new section in the GWAPPINT.INF 
file by surrounding the name of the program with square brackets. For 
example, [WPWIN.EXE]. Use the following options to define the integration: 

!  Integrations=2: If the application is ODMA-compliant, specify 
Integrations=2.

! Integrations=1: If the application has its own macro language and you 
want to write a startup macro, use Integrations=1, followed by 
AppKey=application_name. Use the application to create the 
startup macro and place the startup macro in the application's startup 
directory. 

! DualExe: For some applications, the name of the file containing the 
actual application is different from what you type to start the application. 
For example, to start WordPerfect 6.1, you type WPWIN, but the 
WordPerfect 6.1 program is actually contained in a file named 
WPWIN61.EXE. For such applications, you use the name of the program 
that starts the application as the section heading. For example, 
[WPWIN.EXE]. Then you use DualExe to specify the name of the file 
that actually contains the application. For example, 
DualExe=WPWIN61.EXE. You would need to consult the application 
documentation or its installation directory to determine the filename to 
use with DualExe.
76 Troubleshooting 2: Solutions to Common Problems

Troubleshooting 2: Solutions to Common Problems
104-001298-001
April 10, 2000

Novell Confidential



Manual Rev 99a25 7 March 00
Administrator Wants to Distribute Standardized Integrations
Problem: You have created a custom integration between a new application and the 

GroupWise client. You want all GroupWise users to have access to this new 
integration. 

Action: You can distribute copies of the updated GWAPPINT.INF file for all users to 
place in their \WINDOWS\SYSTEM directories. This file is not replaced 
when Setup is run; therefore, customizations are preserved through updates. 
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V Strategies for Client Problems

This part of Troubleshooting 2: Solutions to Common Problems helps you 
resolve problems users encounter when running the GroupWise® client or 
GroupWise Remote.

! �GroupWise Client Problems� on page 81

! �GroupWise Remote Problems� on page 89
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GroupWise Client Problems

If these troubleshooting strategies do not solve the problem, see Novell 
Support Connection® Worldwide Sites (http://www.support.novell.com/misc/
worldwide.htm).

! �User Can't Start the GroupWise Client� on page 82

! �User Receives an Error Message and Code� on page 82

! �User Forgets His or Her GroupWise Password� on page 83

! �User Isn't Notified of New Messages� on page 83

! �User Can't Access Archived Messages� on page 83

! �Wrong Date/Time Appears in Messages� on page 84

! �Status Isn't Being Returned for Sent Messages� on page 84

! �User's Message Isn't Delivered� on page 84

! �Users Don't Appear in the Address Book or Appear Multiple Times� on 
page 85

! �Screen Information Isn't Being Updated Immediately� on page 85

! �User Is Notified of a New Message but the Message Isn't Received� on 
page 86

! �User Has Print Problems with Franklin Planner Pages� on page 86

! �User Experiences a Delay When Starting the Client or Using Certain 
Client Features� on page 86

! �User Experiences a Delay When Viewing or Printing� on page 87

! �User Wants to Set Up Custom Views� on page 87
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User Can't Start the GroupWise Client

Problem:  A user can�t start the GroupWise® client.

Possible Cause: The user doesn�t exist in the post office yet.

Action: Verify you�ve added the user to a post office. See "Creating GroupWise User 
Accounts" in "Users" in the Maintenance guide.

Possible Cause: If using direct access, the user�s drive mapping is incorrect.

Action: Make sure the user has a drive mapping to the post office directory.

Action: Make sure the user has rights to his or her post office directory. See 
"GroupWise User Rights" in the Security guide.

Action: If the GroupWise client still doesn�t find the post office directory, use the /ph 
startup switch on the command line to point to the post office directory.

Action: If users are running the GroupWise client on NT, make sure their drive 
mappings to the GroupWise code are all the same. If users use different drive 
letters for the location of the GroupWise code, some will receive OLE errors 
on startup.

Possible Cause: If using client/server access, the user�s TCP/IP information may be incorrect. 

Action: Make sure the user's post office is set up for client/server access. See "Using 
Client/Server Access to the Post Office" in "Reconfiguring the POA" in the 
Agent Setup guide.

Action: Set up a GroupWise name server. See "Configuring a GroupWise Name 
Server" in "Reconfiguring the POA" in the Agent Setup guide.

Action: Use the /ipa and /ipp client startup switches to provide the correct IP address 
and TCP port information.

Possible Cause: Multiple users have the same network ID.

Action: If users share the same network ID, but have different GroupWise user IDs, 
start the GroupWise client using the /@u client startup switch.

User Receives an Error Message and Code
Explanation: The user receives an error message and code while using the GroupWise 

client. 

Action: See "GroupWise Engine Error Codes" in Troubleshooting 1: Error Messages. 
If the error code you received is not in the list provided, standard solutions are 
not yet available.
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Action: Use the Search feature of the GroupWise online documentation to locate a 
GroupWise error code or message text. If the error you received is not found, 
standard solutions are not yet available.

Action: If you cannot locate the specific error message or the suggested actions do not 
resolve the problem, see �General Troubleshooting Strategies� on page 9.

User Forgets His or Her GroupWise Password
Problem: The user places a password on his or her GroupWise mailbox, then later 

forgets it. 

Action: Use NetWare® Administrator to reset the user's password. See "Changing a 
User's Password" in "Users" in the Maintenance guide. Then notify the user 
of the new password. 

User Isn't Notified of New Messages

Problem: The user does not receive notifications when new GroupWise messages 
arrive. 

Possible Cause: The user hasn�t turned on the Notify feature yet.

Action: Make sure Notify is turned on in the user's GroupWise client and the user is 
subscribed to Notify. In the GroupWise client, click Tools > Options 
> double-click Security > Notify. Make sure the user is listed in the 
Notification List and Subscribe to Notify is selected.

Possible Cause: Notify isn�t running on the user�s workstation.

Action: Make sure Notify is running for the user. By default, Notify is added to the 
user's Startup group when GroupWise Setup runs, but the user might have 
removed it. If necessary, rerun Setup to place Notify in the user's Startup 
group.

User Can't Access Archived Messages

Explanation: The user has archived GroupWise messages onto the hard disk of his or her 
computer. Later, the user cannot access the archived messages. 

Possible Cause: The user doesn�t have an archive path set or has an invalid archive path set.

Action: Verify that the archive path specified under File Location in the GroupWise 
client is valid. In the GroupWise client, click Tools > Options > double-click 
Environment > click File Location > check the setting for Archive Directory.

Possible Cause: The user�s archive is damaged.
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Action: In GroupWise 5.x, the GroupWise client automatically fixes most problems it 
detects with archive databases each time it starts. In addition, you can run 
GWCheck to fix more difficult problems the client can't handle. See 
"GroupWise Check (GWCheck)" in "Stand-Alone Maintenance Programs" in 
the Maintenance guide.

Wrong Date/Time Appears in Messages
Problem: The wrong date or time or both appear in GroupWise messages. 

Possible Cause: The time zone and daylight saving time information for the user�s post office 
and/or domain are incorrect.

Action: Use NetWare Administrator to check the domain and post office objects to 
make sure the time zone and daylight saving time settings are correct.

Possible Cause: The local time on the user�s workstation is incorrect.

Action: Check the local time on the user's workstation.

Possible Cause: The local time of the servers or workstation where the GroupWise agents are 
running is incorrect.

Action: Check the local time of the servers or workstations where the GroupWise 
agents are running.

Status Isn't Being Returned for Sent Messages
Problem: The user is unable to determine if recipients have received messages because 

no status information appears in the user's mailbox. 

Possible Cause: The user has turned off status information.

Action: Ensure the status level in the user's GroupWise client is set to a level other than 
None. In the GroupWise client, click Tools > Options > double-click 
Send > click Mail/Phone > check the selected Status Information setting.

Possible Cause: Status information has been turned off for a gateway through which messages 
must pass.

Action: Check the status level set for the gateway. In the NetWare Administrator 
browser window, click the Gateway object > Optional Gateway Settings 
> check the selected Outbound Status Level setting.

User's Message Isn't Delivered

Problem: The user sends a GroupWise message, but one or more recipients do not 
receive it. 
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Possible Cause: The user elected to delay delivery.

Action: Ensure that the user does not have Delay Delivery selected in the GroupWise 
client. In the GroupWise client, click Tools > Options > double-click 
Send > type the number of days to delay in the For n Days field.

Possible Cause: Message transfer has been interrupted at some point between sender and 
recipients.

Action: Check the user's mailbox for status information.

Action: For additional strategies, see �Strategies for Message Delivery Problems� on 
page 37.

Users Don't Appear in the Address Book or Appear Multiple Times

Problem: Valid GroupWise users are missing from the Address Book or are listed more 
than once. 

Possible Cause: The user�s visibility has been set so the user is not visible to other users even 
though the user exists.

Action: Use NetWare Administrator to check the users' visibility. See "Controlling 
Object Visibility in the Address Book in "Addressing" in the Maintenance 
guide.

Possible Cause: User information in the local post office is not synchronized with the rest of 
the GroupWise system.

Action: Use NetWare Administrator to synchronize the users' information. See 
"Synchronizing Individual Users or Resources in "Databases" in the 
Maintenance guide.

Screen Information Isn't Being Updated Immediately

Problem: The user performs an action in the GroupWise client but does not see the 
results of that action. For example, the user sends a message but does not see 
that message in the mailbox. Or the user deletes sent messages from the 
mailbox but the messages are still displayed. 

Action: By default, the GroupWise client updates the screen once every minute. Users 
can specify a shorter update interval in the client so their screen information 
is updated more frequently; this will also increase network traffic because the 
client will be polling the users' mailboxes more often. In the GroupWise 
client, click Tools > Options > double-click Environment > click 
General > adjust the Refresh Interval setting. 
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User Is Notified of a New Message but the Message Isn't Received

Problem: The user receives notification a new GroupWise message has arrived but the 
message does not appear in the user's mailbox. 

Possible Cause: The message may have been retracted by the sender before the recipient could 
open it.

Action: None.

Possible Cause: The message may have had a rule or filter applied to it.

Action: Have the user check for unwanted rules or filters in the GroupWise client. For 
rules, click Tools > Rules to list existing rules. For filters, check which filters 
are selected on the GroupWise client toolbar.

Possible Cause: Message transfer has been interrupted at some point between sender and 
recipients.

Action: For additional strategies, see �Strategies for Message Delivery Problems� on 
page 37.

User Has Print Problems with Franklin Planner Pages
Problem: The user is having problems printing GroupWise task and scheduling 

information on Franklin Day Planner* pages. 

Action: If the printing is not lining up with the lines on the preprinted Franklin Day 
Planner pages, use the Preprinted Page Adjustment setting to line up the text. 
The user should have to do this only once a year for each package of Franklin 
Day Planner pages. To adjust the spacing, click File > Print Calendar > 
Calendar Options > use the Preprinted Page Adjustment setting to accurately 
position the text on the Franklin Day Planner pages.

Action: If the Franklin Day Planner pages are printing immediately, without waiting 
for the preprinted Franklin Day Planner pages to be manually fed into the 
printer, click File > Print > Calendar > Printer Setup > Properties > set Paper 
Source to Manual Feed.

User Experiences a Delay When Starting the Client or Using Certain Client Features

Problem: The client user connects to the post office in client/server mode. DNS names 
have been configured on the system. The client user experiences a lengthy 
delay when performing one of the following activities:

! Starting the GroupWise client

! Accessing a shared folder for the first time
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! Accessing a query folder where sources are located in a different post 
office

! Using Find where sources are located in a different post office

! Accessing the Address Book for the first time

! Performing a cross-post office proxy

Possible Cause: The DNS search order for the user�s workstation includes unavailable DNS 
servers.

Action: Make sure the client workstation has the DNS search order set up correctly. 
The features listed above often require IP address information. If your system 
is configured with DNS names, these must be resolved to IP addresses by the 
client as these features are used. For each unavailable DNS server (IP address) 
that precedes an available DNS server in the configured search order, the 
client will experience a delay while timing out waiting to resolve DNS names.

User Experiences a Delay When Viewing or Printing
Problem: Problem: A user experiences a lengthy delay when performing one of the 

following activities in the GroupWise client:

! Viewing an attachment

! Viewing a document

! Viewing mailbox items using QuickViewer

! Viewing item properties

! Printing items or attachments

Possible Cause: The user does not have a default printer set up.

Action: Make sure the user has a valid default printer defined. Printer information is 
used for viewing as well as printing.

User Wants to Set Up Custom Views
Problem: A user or the administrator wants to set up custom views in the GroupWise 

client, as was available in the GroupWise 4.1 client.

Explanation: The View Designer is not available as a standard part of GroupWise 5.x. 
Instead it is available to administrators through Novell Developer Support 
(http://developer.novell.com/engsup/sample/areas/groupwisei.htm)

Action: For product information, contact your local Novell sales office. See Novell 
International Sites (http://www.novell.com/corp/intl/index.html).
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Action: Custom views created by a user or administrator can be used as standard 
views. First, add the custom *.VEW files to the OFVIEWS directory in the 
post office to make them available to all users. Then modify the appropriate 
*.INI file to make the new views appear on the menu for users to select.
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GroupWise Remote Problems

If these troubleshooting strategies do not solve the problem, see Novell 
Support Connection® Worldwide Sites (http://www.support.novell.com/misc/
worldwide.htm).

! "Remote Client Error Messages" in Troubleshooting 1: Error Messages

! �User Cannot Connect to the Master GroupWise System� on page 89

! �Remote Message Flow Is Blocked� on page 90

! �Remote Mailbox Is Damaged� on page 90

User Cannot Connect to the Master GroupWise System
Problem: You cannot establish a connection from GroupWise® Remote to your master 

GroupWise system.

Action: Use the Remote Connection Log to display connection information and to 
troubleshoot connection problems. This log includes information about 
connection time, error messages, and so forth. 

GroupWise uses three files to log the connection information. These files are 
REMOTE1.LOG, REMOTE2.LOG, and REMOTE3.LOG. GroupWise uses 
the next log file each time you run GroupWise Remote against your Remote 
mailbox. 

If you want to save the transmission information, select the information you 
want to save, right-click the connection log > click Copy. You can save this 
information in a text file. 
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Remote Message Flow Is Blocked

Problem: Messages are not being transferred to/from GroupWise Remote.

Action: To see how a message should travel to and from GroupWise Remote, see 
"Message Delivery to/from GroupWise Remote" in Troubleshooting 1: Error 
Messages.

Remote Mailbox Is Damaged
Problem: GroupWise Remote is not functioning correctly because it cannot access its 

Remote mailbox.

Action: Verify that the structure of the Remote mailbox is correct. See "Remote 
Mailbox Directory" in Troubleshooting 1: Error Messages.

Action: Repair the Remote mailbox. See "GroupWise Check (GWCheck)" in "Stand-
Alone Maintenance Programs" in the Maintenance guide.
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